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1. Wprowadzenie teoretyczne 
Człowiek z dość dużą precyzją bardzo często potrafi sterować wieloma urządzeniami 

technicznymi lub wykonywać działania, które można nazwać sterowaniem. Efektywność 
poprawia się wraz z gromadzeniem wiedzy doświadczalnej na temat zachowania się 
konkretnego urządzenia. Przykładowo kierowanie pojazdem samochodowym tj. ruchem po 
określonej trajektorii wymaga nabytych w drodze doświadczeń informacji na temat 
właściwości dynamicznych pojazdu, takich jak przyspieszenie, czy droga hamowania. 
Podobnie sternik podpływający łodzią do nabrzeża musi sobie zdawać sprawę z bezwładności 
i oporów hydro- i aerodynamicznych kierowanej przez siebie jednostki, gdyż w przeciwnym 
przypadku może rozbić łódź lub nabrzeże. Okazuje się więc, że perfekcyjnemu, w wielu 
przypadkach, „układowi sterowania”, jakim jest człowiek potrzebne są informacje o procesie. 
Tym bardziej informacje o dynamice w postaci modelu matematycznego będą potrzebne 
układowi automatycznego sterowania. 

Model matematyczny procesu sterowanego (obiektu) powinien reprezentować dany układ 
fizyczny z punktu widzenia celowego oddziaływania (sterowania) na zachodzące w tym 
układzie zmiany za pośrednictwem określonych wielkości fizycznych (akcji sterujących). 
Przykładowo silnik prądu stałego może stanowić obiekt sterowania prędkością obrotową, na 
którą można wpływać za pomocą napięcia. W ten sposób tworzy się zależność między 
przyczyną i skutkiem. Jeśli zapiszemy ją w języku matematyki, otrzymamy model dynamiki. 
Na jego podstawie automatyk może zaproponować takie rozwiązanie w postaci układu 
sterującego (regulator w określonej konfiguracji), które zapewni pożądane zachowanie 
obiektu. Innymi słowy dobór algorytmu sterowania powinien odbywać się w sposób 
analityczny z dość dobrą znajomością dynamiki procesu sterowanego, natomiast dostrajanie 
algorytmu sterowania w warunkach rzeczywistych może być przeprowadzone metodą prób i 
błędów, co zwykle ma miejsce. 

Model matematyczny systemu dynamicznego może być zdefiniowany jako zestaw 
równań, które reprezentują dynamikę systemu z dokładnością pozwalającą na odwzorowanie 
jego rzeczywistego zachowania. W praktyce takie równania są wyprowadzane z 
wykorzystaniem praw fizycznych rządzących wybranym systemem np. praw Newtona dla 
układów mechanicznych i praw Kirchhoffa dla układów elektrycznych.  

Proces sporządzania modelu matematycznego przedstawia w sposób uproszczony 
schemat blokowy (rys.1.1). 

Po stworzeniu modelu matematycznego konieczne jest przeprowadzenie drugiego etapu 
identyfikacji - określenie wartości parametrów otrzymanego modelu. Dokonuje się tego 
najczęściej drogą eksperymentalną, przy czym pomiary są tym trudniejsze, im bardziej 
skomplikowany jest opis procesu, im więcej informacji jest wymaganych i im większa musi 
być dokładność.  
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Rys.1.1. Modelowanie i analiza własności dynamicznych. 
 
Szerzej zagadnienie modelowania dynamiki układów mechanicznych, elektrycznych i 

płynowych omówiono w [8]. 
Obecnie dość powszechne jest wykorzystywanie modelu systemu zapisanego w pamięci 

komputera.  Jest on wygodny do demonstracji zachowania się systemu i może być 
wykorzystany wielokrotnie w trakcie projektowania różnych układów regulacji. W symulacji 
komputerowej można ponadto wykorzystywać sygnały zarejestrowane w systemie 
rzeczywistym, co wpływa na poprawę jakości modelu. 

Celem ćwiczenia jest zapoznanie się z podstawowymi technikami modelowania i badania 
układów dynamicznych ciągłych i dyskretnych, w tym również z aspektami numerycznymi 
zagadnienia modelowania. W trakcie ćwiczeń wykorzystywany będzie program MatLab v.6.5 
lub 7.01 wraz z przybornikami Control System Toolbox oraz Simulink. Efektem końcowym 
zajęć ma być uzyskanie wiedzy praktycznej, dotyczącej metod analizy własności 
dynamicznych z użyciem oprogramowania wspomagającego. Dodatkowe informacje na temat 
wykorzystania środowiska MatLab w teorii regulacji można znaleźć w [6]. 

1.1 Cel i sposób sporządzania charakterystyk czasowych 
W przypadku syntezy prostych układów sterowania (np. układów regulacji jednej 

zmiennej SISO) dla typowych, znanych obiektów często nie przeprowadza się etapu opisu 
matematycznego, ściślej mówiąc korzysta się ze znanego już gotowego modelu 
matematycznego. Model ten zwykle znany jest w postaci transmitancji operatorowej. 
Wówczas zdejmuje się charakterystykę dynamiczną obiektu lub układu automatyki będącą 
wynikiem odpowiedzi obiektu na standardowe wymuszenie i na jej podstawie ustala się 
wartość współczynników tej transmitancji. Dokonuje się w ten sposób identyfikacji dynamiki. 
Na szczególną uwagę zasługują : charakterystyki czasowe - tj. odpowiedź układu (elementu) 
na impuls Diraca (ch. impulsowe) lub skok jednostkowy sygnału wejściowego (ch. skokowe) 
oraz charakterystyki częstotliwościowe. Charakterystyki te można uzyskać metodą 
pomiarową rejestrując przebieg sygnału wejściowego przy podaniu odpowiedniego 
wymuszenia np. skoku jednostkowego (napięcia, siły, momentu, natężenia dopływu, ciśnienia 
itp.) zazwyczaj łatwego do zrealizowania. Typowe wymuszenia przedstawia rysunek poniżej : 
 
 Impuls Diraca Skok jednostkowy Sinusoida Sygnał typu „rampa” 

 
 u(t)=δ(t) u(t)=1(t) x(t)=u0sinωt u(t)=1(t)⋅t 
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Powszechną praktyką w projektowaniu liniowych układów regulacji jest posługiwanie się 
modelami tzw. podstawowych członów dynamicznych. Praktycznie każdy liniowy obiekt 
regulacji można próbować przybliżyć podstawowym członem dynamicznym lub połączeniem 
kilku. Poniżej przedstawiono ich wykaz wraz z funkcją przejścia (transmitancją operatorową) 
i charakterystyką skokową. 

Charakterystyki skokowe typowych członów dynamicznych 
 
Zakładamy, że amplituda skoku jednostkowego wynosi u0(t)  
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Wiadomości uzupełniające do podstawowych członów dynamicznych można znaleźć 
w [1,15,37]. 

1.2 Cel i sposób zdejmowania charakterystyk częstotliwościowych 
W celu określenia właściwości nieznanego obiektu można również zdejmować 

charakterystyki częstotliwościowe : amplitudowo-fazową (wykres Nyquist’a) oraz 
logarytmiczne : amplitudową i fazową (wykresy Bode’go). Stosuje się tu m. in. metodę fali 
sinusoidalnej (istnieją także metody fali trójkątnej, prostokątnej, trapezowej i inne). 

Metoda ta polega na wprowadzaniu do wejścia obiektu wymuszenia harmonicznego o 
zmiennej częstotliwości i stałej amplitudzie - rys.1.2. Po ustaleniu się drgań na wyjściu 
obiektu określa się ich amplitudę i przesunięcie fazowe względem drgań wejściowych. 
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Rys.1.2 Praktyczne zdejmowanie charakterystyk częstotliwościowych. 
 

Zarówno przebieg wielkości wejściowej jak i wyjściowej jest mierzony za pomocą 
rejestratora. Dzięki jednoczesnemu odwzorowywaniu obu wielkości możliwe jest uchwycenie 
przesunięcia fazowego między nimi. 

Na podstawie uzyskanych wykresów sporządza się charakterystyki częstotliwościowe. 
 

Przykład : Charakterystyka amplitudowo-fazowa elementu inercyjnego 1-go rzędu o 
transmitancji : 
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Rys.1.3. Charakterystyka amplitudowo- 
fazowa elementu inercyjnego 1-go rzędu 
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Na wykresie nanosimy punkty odpowiadające kolejnym częstotliwościom 

wymuszającym, określone przez stosunek amplitud R
A
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wy =  i kąt przesunięcia fazowego ϕ. 

Charakterystykę amplitudowo-fazową można zastąpić 2-ma charakterystykami : amplitu-
dowo-częstotliwościową i fazowo-częstotliwościową, przy czym na osiach współrzędnych 
nanosi się skalę logarytmiczną.1 
                                                 
1 Podziałka osi ω jest logarytmiczna, dekadowa tzn. każdej dekadzie ω odpowiada odcinek o jednakowej 
długości na osi ω. 
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Rys.1.4. Charakterystyki częstotliwościowe : amplitudowa i fazowa. 
 

Charakterystyki częstotliwościowe podstawowych elementów dynamicznych 
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Rys. 1.5. Charakterystyki częstotliwościowe 
 
 
a) amplitudowa - fazowa 
 
 
 
 
b) logarytmiczna amplitudowa 
 
 
 

 
Element inercyjny 1-go rzędu 
Na przykładzie elementu zostanie przedstawiony sposób analitycznego wykreślania 
charakterystyki na podstawie modelu w postaci transmitancji operatorowej G(s) : 

( )
1+

=
sT

ksG  

Krok 1 : Podstawiamy s = jω (tzw. zespolona pulsacja), gdzie 1−=j . Jako wynik 
uzyskujemy transmitancję widmową )j(G ω . 

( )
221

1
1
1

1 T
Tjk

Tj
Tj

Tj
K)j(G

ω+
ω−

=
ω−
ω−

⋅
ω+

=ω  

wy

wy

A
A

log20  

Im(jω) 

Re(jω)

ω= 0÷∞ 

k

logω

 [dB] klog20  



Laboratorium nr 1 - Modelowanie i analiza własności dynamicznych obiektów regulacji 

Krok 2 : Wyodrębniamy ( )ωRe  - część rzeczywistą i ( )ωIm  - część urojona 
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Krok 3 : Podstawiając kolejno ω = ÷ ∞0  możemy zbudować charakterystykę amplitudowo-
fazową : 

 
Rys.1.6. Charakterystyka amplitudowo - fazowa elementu inercyjnego 1 - go rzędu. 
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Rys. 1.7.Charakterystyki częstotliwościowe 
a) amplitudowo-fazowa 
 
 
 
 
 
 
 
 
b) logarytmiczna amplitudowa 
 

Rys. 1.8.Charakterystyki częstotliwościowe 
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Rys.1.9. Charakterystyki częstotliwościowe  
 
a) amplitudowo-fazowa 
 
 
 
 
 
 
 
 
 
b) logarytmiczna amplitudowa 
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2. Część praktyczna 
2.1.Analiza w Control System Toolbox (CST)  

Systemy liniowe mogą być reprezentowane w CST poprzez : 
• opis w postaci transmitancji operatorowej [1,15,37] 
• opis w przestrzeni w stanu. 

W przypadku zapisu operatorowego współczynniki wielomianu licznika i mianownika 
funkcji przejścia (transmitancji) są wprowadzane w postaci wektorów wierszowych. Tak więc 
mając daną ogólną postać funkcji przejścia n – stopnia : 
 

 
01

1
1

01
1

1

asa...sasa
bsb...sbsb)s(G n

n
n

n

m
m

m
m

+++
+++

= −
−

−
−  n ≥ m 

 
w przestrzeni Matlaba reprezentują ją dwa wektory : 

 
>> licz = [bm, bm-1,…,b1, b0];2 
>> mian = [an, an-1,…,a1, a0]; 

Przykład : 

35273
3725)( 234

23

++++
+++

=
ssss

ssssG
 

 
>> licz = [5,2,7,3]; 
>> mian = [3,7,2,5,3]; 
 

Obecna wersja CST umożliwia również definiowanie obiektów za pomocą funkcji tf.  
Funkcja tf umożliwia przypisanie wektorów licz i mian do obiektu. Wpisanie nazwy obiektu 
i zatwierdzenie z linii komend spowoduje wyświetlenie transmitancji.  
 
Przykład : 
>> obiekt = tf(licz,mian) 
>>obiekt 
Transfer function: 
    5 s^3 + 2 s^2 + 7 s + 3 
------------------------------- 
3 s^4 + 7 s^3 + 2 s^2 + 5 s + 3 

 
Transmitancja operatorowa może zostać zapisana w zmienionej formie w postaci 

iloczynowej, w której wielomian licznika i mianownika rozkłada się odpowiednio na iloczyn 
n i m dwumianów. Miejsca zerowe dwumianów stanowią wartości charakterystyczne 
transmitancji i nazywane są odpowiednio dla mianownika biegunami bi, natomiast dla 
licznika zerami zj.  
 

 0 1

0 1
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s z s z s zG s k
s b s b s b
± ⋅ ± ⋅ ⋅ ±

= ⋅
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2 Średnik na końcu polecenia wpisywanego z linii komend powoduje wyłączenie efektu „echa” tj. wyświetlania 
wyniku działania polecenia. Szczególnie przydatne w trakcie wyliczania dużych serii danych. 
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Dodatkowo przy tego typu zapisie w liczniku będzie występował współczynnik 
skalujący k, który błędnie nazywany jest w Matlabie wzmocnieniem3.  

W tym przypadku, chcąc przeanalizować działanie obiektu reprezentowanego przez 
model w postaci transmitancji, należy zadeklarować wartości zer i biegunów oraz 
współczynnika skalującego 

0 1[ , , , ];mZ z z z= m m K m  

0 1[ , , , ];mB b b b= m m K m  
K =k; 

a następnie przekształcić do poznanej wcześniej transmitancji w wersji standardowej 
 
Przykład : 

( 3)( 2)( 0.5)( ) 5
( 3)( 2)( 0.5)( 1)( 0.2)

s s sG s
s s s s s

+ + +
= ⋅

+ + + + +  
 
>> Z = [-3,-2,-0.5]; 
>> B = [-3,-2,-0.5,-1,-0.2]; 
>> K = 5; 
 
[licz,mian] = zp2tf(Z,B,K); 
 

Polecenie tf2zp spowoduje z kolei wyświetlenie wartości zer, biegunów i wzmocnienia, 
jeśli wcześniej zadeklarowano transmitancję w sposób poprzednio prezentowany. 
CST oferuje wiele przydatnych przy analizie liniowych układów automatycznej regulacji. Są 
to m. in. : 

1. Ogólne 
ctrlpref – Ustawianie właściwości Control System Toolbox 

2. Tworzenie modeli liniowych 
tf – Tworzenie transmitancji operatorowej. 
zpk – Tworzenie modelu w postaci transmitancji iloczynowej. 

3. Przekształcenia  
tf  lub tf2zp – Przejście z modelu iloczynowego do transmitancji operatorowej 
zpk lub zp2tf – Przejście z transmitancji operatorowej do modelu iloczynowego 
c2d lub c2dm– Zamiana modelu ciągłego w dyskretny 
d2c – Zamiana modelu dyskretnego w ciągły 

4. Algebra schematów blokowych 
parallel – upraszczanie połączenia równoległego 
series – upraszczanie połączenia szeregowego 
feedback – upraszczanie połączenia typu sprzężenie zwrotne 

5. Analiza transmitancji operatorowych 
pole – wyznaczanie biegunów transmitancji 
zero – wyznaczanie zer transmitancji 
pzmap – wykreślanie lub wyznaczanie zer i biegunów transmitancji 

6. Analiza czasowa 
ltiview – narzędzie graficzne do analizy czasowej i częstotliwościowej (LTI Viewer) 
step - generowanie odpowiedzi skokowej 
impulse – generowanie odpowiedzi impulsowej 
lsim – generowanie odpowiedzi na zadany wektor pobudzający 

                                                 
3 W teorii regulacji pojęcie wzmocnienia występuje wtedy, kiedy wszystkie wyrazy wolne wielomianów zostaną 
sprowadzone do jedności. 
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gensig – prosty generator pobudzeń dla funkcji lsim 
7. Analiza częstotliwościowa 

ltiview – narzędzie graficzne do analizy czasowej i częstotliwościowej (LTI Viewer) 
bode – generowanie logarytmicznych charakterystyk modułu I fazy 
bodemag – generowanie logarytmicznej charakterystyki modułu 
nyquist – generowanie charakterystyki amplitudowo-fazowej 
margin – wyznaczanie zapasu modułu i fazy (przydatne w trakcie syntezowania 
układu regulacji metodą częstotliwościową) 

 
Wykaz wszystkich dostępnych w ramach CST4 funkcji można uzyskać wpisując : 

>> help control 
Analizę własności dynamicznych będziemy głównie prowadzić w oparciu o polecenia z 

grup 6 i 7. 
 

Przykład : 
>> step(obiekt) lub step(licz,mian) 

Wprowadzenie polecenia spowoduje wygenerowanie okna z charakterystyką skokową. 
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Rys.1.10. Charakterystyka skokowa wygenerowana w MatLabie. 

 
Funkcja step może być wykorzystana w inny sposób. 

>> [y,t]=step(obiekt); lub [y,x,t]=step(licz,mian);5 
Wykonanie polecenia spowoduje wygenerowanie wektorów y i t. 
 
Dodatkowe możliwości funkcji można wyświetlić wpisując : 

>> help step 
W podobny sposób działają pozostałe funkcje z  grup 6 i 7. 

Zadanie 1 – Analiza podstawowych członów dynamicznych 
Dla wymienionych poniżej obiektów należy wyznaczyć charakterystyki : 

A. czasowe : 
• skokową - (step(licz,mian) lub step(obiekt)) 
• impulsową - (impulse(licz,mian) lub impulse(obiekt)) 

B. częstotliwościowe : 
• amplitudowo - fazową (nyquist(licz,mian) lub nyquist(obiekt)) 

                                                 
4 Na stronie http://www.mathworks.com/access/helpdesk/help/toolbox/control/control.html znajduje się obszerna 
dokumentacja dotycząca CST. 
5 W tym przypadku zmienna x reprezentuje wektor zmiennych stanu. Funkcja step w takim zapisie może dawać 
błędne wyniki !!! 



Laboratorium nr 1 - Modelowanie i analiza własności dynamicznych obiektów regulacji 

• logarytmiczną amplitudową i fazową - (bode(licz,mian) bode(licz,mian)) 
 

Dla obiektów 5 i 6 dodatkowo należy wyznaczyć bieguny (roots(mian)) i zera 
(roots(licz))6 oraz określić ich położenie na płaszczyźnie Gaussa (pzmap(licz,mian)). 

1. Obiekt inercyjny I –go rzędu: 
1sT

k)s(G
+

=  

Zespół  1.  2.  3.  4.  5.  6.  7.  8.  
5 4 3 2 2 1 8 2 k 10 8 6 4 5 5 16 9 
2 3 4 3 6 1 5 10 T 10 6 8 6 7 5 10 20 

2. Obiekt całkujący: 
CsT

1)s(G =  

Zespół  1.  2.  3.  4.  5.  6.  7.  8.  
2 3 4 3 6 1 5 10 Tc 10 6 8 6 7 5 10 20 

3. Obiekt całkujący rzeczywisty: 
)1sT(sT

1)s(G
C +

=  

Zespół  1.  2.  3.  4.  5.  6.  7.  8.  
5 4 3 2 2 1 8 2 Tc 10 8 6 4 5 5 16 9 
2 3 4 3 6 1 5 10 T 10 6 8 6 7 5 10 20 

 

4. Obiekt różniczkujący rzeczywisty:
1sT

sT)s(G r

+
=  

Zespół  1.  2.  3.  4.  5.  6.  7.  8.  
5 4 3 2 2 1 8 2 Tr 10 8 6 4 5 5 16 9 
2 3 4 3 6 1 5 10 T 10 6 8 6 7 5 10 20 

5. Obiekt II rzędu: 
1s2s

K)s(G

o
2
o

2

+
ω
β

+
ω

=  

Zespół  1.  2.  3.  4.  5.  6.  7.  8.  
5 4 3 2 2 1 8 2 k 10 8 6 4 5 5 16 9 
2 3 4 3 6 1 5 10 ω0 10 6 8 6 7 5 10 20 

β 

0.1 
0.5 
1 
2 

                                                 
6 Wartości zer i biegunów można również wyznaczyć poleceniem pzmap (licz, mian) lub pzmap(obiekt), w tym 
przypadku należy zwrócić wartość działania funkcji do wektora dwuelementowego, ponieważ standardowo 
pzmap generuje płaszczyznę zmiennych zespolonych z oznaczonymi pierwiastkami wielomianów licz i mian 
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Analiza własności dynamicznych wykorzystaniem m-skryptu 
Wpisywanie ciągów poleceń z linii komend jest uciążliwe, a ponadto w przypadku 

awaryjnego wyłączenia programu użytkownik może stracić wynik swojej pracy. Należy 
raczej tworzyć tzw. m-skrypty stanowiące pliki tekstowe zapisywane z rozszerzeniem *.m. W 
najprostszym przypadku jest to po prostu ciąg komend, stanowiących zawartość 
standardowych bibliotek MatLaba i tzw. toolbox’ów. Więcej na temat programowania w 
języku m można znaleźć w [5, 7].  

Poniżej przedstawiono szkielet m-skryptu, umożliwiającego przeprowadzenie analizy 
własności dynamicznych nieskomplikowanego obiektu regulacji. 
przyklad.m 
%Komentarz do m-pliku powinien zawierać istotne informacje dotyczące przedmiotu tj. obiektu 
%dynamicznego i zakresu eksperymentu symulacyjnego tj. istotnych szczegółach metodyki. 
%Data utworzenia : 30.09.2004 
%Ostatnia modyfikacja : 16.09.2005 
%Autor(zy) : Sławomir Jaszczak 
%Komentarz w m-pliku stanowi jednocześnie pomoc dla innych użytkowników. Wywołanie polecenia 
%help przykład.m spowoduje wyświetlenie komentarza do pierwszej pustej linii lub pierwszej 
%napotkanej linii kodu 
 
close all %zamknięcie wszystkich okien graficznych 
clear %czyszczenie pamięci roboczej MatLab 
clc % usunięcie wszystkich poleceń wpisywanych i zatwierdzanych z linii komend 
 
%deklaracja współczynników transmitancji 
licz = [5,2,7,3]; 
mian = [3,7,2,5,3]; 
 
printsys(num,den)%wyświetlenie postaci transmitancji 
 
%----------------Analiza czasowa-------------------- 
%charakterystyka skokowa 
step(num,den) 
%charakterystyka impulsowa 
impulse(num,den) 
%----------------Analiza częstotliwościowa-------------------- 
%charakterystyka amplitudowo-fazowa 
nyquist(num,den) 
%charakterystyka Bode'go 
bode(num,den) 
%----------------Analiza zer i biegunów----------------------- 
pzmap(num,den)%mapa zer i biegunów transmitancji 
bieguny,zera]=pzmap(num,den) 

 
Powyższy m-skrypt należy zmodyfikować w celu zapewnienia następujących 

funkcjonalności : 
1. Analiza czasowa i częstotliwościowa oraz położenie zer i biegunów w osobnych 

oknach graficznych (funkcja figure()), przy pierwsze dwa należy dodatkowo 
podzielić na dwa poziome okienka (funkcja subplot()). 

2. Kolejne wykresy mają się pojawiać po przyciśnięciu dowolnego klawisza, co 
również powinno być zasygnalizowane w Matlak Command Window 

3. Współczynniki transmitancji powinny być wprowadzane w trybie dialogowym 
(funkcja input), przy jeśli zostanie zatwierdzony brak wartości do współczynnika 
powinna zostać przypisana wartość domyślna (skorzystać z warunku if end oraz 
funkcji isempty) 

4. Zbadać własności obiektu, zmieniając wybrany parametr w pewnym zakresie (np. 
instrukcja for end lub sterowanie z użyciem suwaka w oknie graficznym) – odczytać 
i umieścić w tabeli : wartości zer i biegunów, pulsację załamania spadek o 3 dB od 
wartości 20logk (obiekt 1), pulsacje przecięcia z wartością 0 (obiekt 2, 3,4,5) oraz 
pulsację rezonansu lub załamania (spadek o 3 dB od wartości 20logk) (obiekt 5) ; 



Laboratorium nr 1 - Modelowanie i analiza własności dynamicznych obiektów regulacji 

5. Zarejestrować przebieg sygnału wyjściowego z układu pod wpływem następującego 
pobudzenia (funkcja lsim, wektor czasu z krokiem 0.1 [s] lub na podstawie funkcji 
gensig napisać własną): 


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




>∈−
>∈

>∈<
=

30:20(t12
]s[20:10(t0

10:0t12
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Zadania dodatkowe 
1. Znaleźć w literaturze i/lub źródłach internetowych przykłady rzeczywistych 

obiektów dynamicznych 1-5 (rysunek i/lub zdjęcie i/lub schemat, model 
matematyczny z opisem zmiennych. 

2. Wyprowadzić analitycznie formuły matematyczne, umożliwiające wygenerowanie 
charakterystyk częstotliwościowych, a następnie napisać m-funkcję w MatLabie. 

2.2.Analiza w Simulinku  
Bardzo ciekawym i funkcjonalnym rozszerzeniem MatLab’a  jest przybornik Simulink. 

Umożliwia graficzne modelowanie systemów dynamicznych z wykorzystaniem 
rozbudowanej biblioteki gotowych elementów. Użytkownik może tworzyć własne elementy 
tworząc je z gotowych komponentów lub pisząc s-funkcje w języku wysokiego poziomu. 
Każdy z elementów posiada własny interfejs. Połączenia między blokami tworzy się za 
pomocą myszy. Simulink daje ponadto możliwość analizowania układów nieliniowych, czego 
brak stanowi poważny niedostatek CST. Wymiana danych z MatLabem następuje na 
poziomie przestrzeni roboczej, tak więc wszystkie zmienne zadeklarowane w Matlab 
Command Window stają się widoczne z poziomu Simulinka. Uruchomienie następuje 
poprzez wpisanie i zatwierdzenie : 
>> simulink 

lub wciśnięcie ikonki  
Pojawia się wówczas okno Simulink Library Browser, które zawiera kilkanaście 

przyborników.W trakcie tego cyklu zajęć najczęściej wykorzystywane będą :Continuous, 
Discontinuities, Discrete, Math Operations, Signal Routing, Sinks i Sources. 

Lista w lewym oknie obejmuje poza Simulinkiem inne przyborniki MatLab’a 
udostępniające funkcje blokowe.  

Szerzej podstawowe funkcje Simulinka omówiono w [6]7 

Zadanie 2 – Modelowanie i analiza rzeczywistego układu dynamicznego 
Proces tworzenia modelu a następnie analizy zostanie przedstawiony na przykładzie 

prostego układu dynamicznego. 
Założenia :  
układ liniowy, czasowo-inwariantny 
R =100 [Ohm] – opór elektryczny,  
c = 0.03 [F] – pojemność elektryczna 
U1(t) – napięcie wejściowe 
U2(t) – napięcie wyjściowe 
 
 
 

                                                 
7 Na stronie http://www.mathworks.com/access/helpdesk/help/toolbox/simulink/simulink.html znajduje się 
obszerna dokumentacja dotycząca Simulinka. 
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Po zbilansowaniu spadków napięć z wykorzystaniem prawa Kirchoffa można zapisać : 
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Wykorzystując następnie przekształcenie Laplace’a można zapisać układ równań 
operatorowych : 
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z której wynika transmitancja operatorowa : 
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Krok 1 : Transmitancję G(s) zapisujemy w postaci równań stanu, rozpisując osobno 

licznik i mianownik transmitancji. 
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gdzie p(s) stanowi pomocniczą transformatę 
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wykorzystując twierdzenie o różniczkowaniu zapisujemy równania w dziedzinie czasu 
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Jak widać zmienna p(t) reprezentuje sygnał wyjściowy.  
 
Krok 2 : Na podstawie równania drugiego wyznaczamy )t(p& . Przyjęcie założenia, że 

znamy zmienną )t(p& tzn. istnieje potencjalny generator sygnału )t(p& , stanowi podstawę do 
utworzenia modelu. 

( )
cR

1)t(p)t(U)t(p 1 ⋅
−=&  

 
Do rozwiązania równania będą potrzebne : elementy sumujące, wzmacniające (Sum i 

Gain z przybornika Math Operations) i całkujące  (Integrator z przybornika Continuous). 
Każdy z wymienionych elementów należy przeciągnąć do okna edycji. Do wejścia obiektu 
należy doprowadzić sygnał pobudzający (tu : skok jednostkowy o określonej amplitudzie) - 
Step Input ze zbioru Sources.  
Krok 3 : Zebrane elementy umożliwiają już zbudowanie modelu matematycznego obiektu. 
Analizując kolejne operacje matematyczne w równaniu, którym poddawane są poszczególne 
sygnały, analogicznie łączy się elementy z odpowiednio wpisanymi parametrami. Wybrane 
operacje na elementach:  
− zmiana parametrów elementu – kliknąć na elemencie Gain dwukrotnie i wpisać nowe 

parametry (tu: zapis symboliczny R * c); 
− rysowanie strzałek - kliknąć na wyjściu jednego elementu i przeciągnij strzałkę do wejścia 

drugiego (połączenia można tworzyć w formie odcinków);  
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− obrót – zaznaczyć element a następnie wybrać z menu Format->Flip Block(lub Ctrl+i). 
 
Efektem działań jest następujący model:   

 
Krok 4 : Istotną zaletą Simulinka jest możliwość obserwacji wszystkich zmiennych stanu 

występujących w modelu dynamicznym. Dla rozpatrywanego przykładu poza przebiegiem 
wartości wyjściowej U1(t) można jednocześnie rejestrować przebieg sygnału wejściowego i 
pochodnej sygnału wyjściowego, którą otrzymujemy na wyjściu elementu sumującego. 
Analizowane sygnały należy doprowadzić do bloku Mux -> Signal Routing, a jego wyjście 
podłączyć do wejścia elementu Scope z przybornika Sinks. 

 
Krok 5 : Tak przygotowany model można przekształcić w nowy element. W celu 

zgrupowania należy zaznaczyć wszystkie elementy w oknie edycyjnym poza elementem Step 
Input, Scope, Mux i wybrać z menu Edit->Create SubSystem. Utworzony element nie 
posiada standardowego okna dialogowego i ikony (po dwukrotnym kliknięciu, zamiast pól do 
określenia parametrów, pokaże się pełna struktura). Zgrupowany model należy zamaskować 
Edit->Mask SubSystem. W zakładce Icon określamy ikonkę bloku (w tym przypadku będzie 
to tekst „Model Rc”). Do wyboru jest wiele opcji w tym bitmapy. 

 

 
W zakładce Parameters definiujemy zmienne, które będą widoczne w oknie 

dialogowym interfejsu. 
 

 

pprim(t) p(t)=U2(t)U1(t) U1(t)-p(t)
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pprim(t)  p(t)=U2(t)U1(t) 

Step Scope
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1
s
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U1(t)-p(t) 
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Odtąd nowy element będzie zachowywał się tak samo, jak standardowe elementy 
Simulinka, czyli po dwukrotnym kliknięciu będzie można wprowadzić wartości parametrów. 

 

 
 

Krok 6 : Obejmuje przygotowanie symulacji : Simulation-> Configuration 
Parameters. Należy określić: metodę rozwiązania, czas symulacji Start Time: 0.0, Stop 
Time : np. 20.0 oraz parametry metody Min Step Size : 0.001, Max Step Size : 1. Symulację 
rozpoczynamy z menu Simulation->Start . 

 
 

 
 

Zadania dodatkowe 
1. Sprawdzić działanie układu przy niezerowych warunkach początkowych (ładunek 

szczątkowy na kondensatorze) – niezerowa wartość początkowa w bloku integratora; 

Wybór metody całkowania 
numerycznego 

Czas początkowy Czas końcowy 

Minimalny krok całkowania 

Maksymalny krok całkowania 

Tolerancja wartości błędu 
całkowania 
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2. Sprawdzić własności filtrujące elementu Rc – podać na wejście elementu pobudzenie 
harmoniczne (np. sinusoida (Signal Generator->Sources)) – zarejestrować przebiegi 
dla pulsacji poniżej i powyżej progu załamania (porównać z wartością wyliczoną). 

3. Umożliwić zapis wyników symulacji (wszystkie zmienne stanu, pobudzenie oraz 
podstawa czasu (Sources->Clock)) do przestrzeni roboczej a następnie napisać m-
skrypt umożliwiający : 

• wygenerowanie dwóch wykresów w osobnych oknach graficznych (u2(t)=f(t) 
wraz z u1(t)=f(t), pprim(t)=f(t) wraz z u1(t)=f(t)); 

• przeprowadzenie symulacji modelu w Simulinku przy zmieniającym się 
parametrze R lub c (wykorzystać funkcję sim() oraz instrukcję for end.)8 

Praca domowa 
Zamodelować i przeanalizować własności dynamiczne rzeczywistego obiektu regulacji 

(wybrać na podstawie tabeli poniżej) zgodnie z przykładami zrealizowanymi w ramach 
laboratorium. 
 
Zespół  1.  2.  3.  4.  5.  6.  7.  8.  

Typ 
obiektu 

Silnik DC 
jako obiekt 
sterowania 
prędkością 

(bez 
obciążenia) 

Silnik DC z 
obciążeniem 

Amortyzator 
samochodowy 

bez 
ogumienia  

Amortyzator 
samochodowy 
z ogumieniem 
(pobudzenie – 

siła) 

Sprzęgło 
hydrauliczne 

Amortyzator 
samochodowy 
z ogumieniem 
(pobudzenie – 

siła) 

Silnik DC 
jako obiekt 
sterowania 

kątem 
obrotu 
(bez 

obciążenia) 

Układ 
pneumatyczny 

zbiornik-
siłownik 
tłokowy 

Wymagania końcowe 
Rozliczenie wykonania ćwiczenia następuje na podstawie sprawozdania, zawierającego 

następujące elementy :  
1. cele, metodyka badań, schematy blokowe, m-skrypty itp.  
2. wyniki badań (postaci transmitancji, wykresy itp.)  
3. wnioski wynikające ze szczegółowej analizy wyników. 

W sprawozdaniu ująć wyniki zadania 1 wraz z zadaniami dodatkowymi i zadania 2 
(tylko zadania dodatkowe) oraz pracy domowej. Integralną część stanowią m-skrypty i 
modele Simulinka, które powinny być przygotowane do ewentualnego uruchomienia i 
omówienia. 
 

Pytania kontrolne 
 
 
 
 
 
 
 

1. Podaj transmitancję, charakterystyki czasowe, charakterystyki częstotliwościowe 
podstawowych elementów automatyki. 

2. Podaj definicję transmitancji operatorowej. 

                                                 
8 Wybrany parametr powinien być wstawiony w postaci symbolicznej w modelu simulinkowym. W podobny 
sposób można sterować wszystkimi parametrami bloków np. wartość skoku jednostkowego, a za pomocą funkcji 
simset() parametrami samej symulacji. 
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3. Podaj składnię polecenia <…> dla obiektu opisanego następującą transmitancją 
operatorową. 

4. Napisz m-skrypt umożliwiający przeprowadzenie analizy czasowej i 
częstotliwościowej modelu ciągłego opisanego równaniem różniczkowym. 

5. Omów metodykę praktycznego sporządzania charakterystyki amplitudowo-fazowej 
obiektu dynamicznego. 

6. Na czym polega różnica między elementem statycznym i dynamicznym ? 
7. W jakich jednostkach określa się przebieg modułu na charakterystyce amplitudowej ? 
8. Wyjaśnij pojęcie zer i biegunów transmitancji. 
9. Porównaj pojęcia sterowanie i regulacja dla układów jednej zmiennej. 
10. Wymień cechy systemu dynamicznego; 
11. Wymień cechy systemu statycznego; 
12. Co to jest rząd układu ? 
13. Co to jest transmitancja operatorowa ? 
14. Jakie warunki musi spełniać równanie różniczkowe, aby można było na jego 

podstawie wyznaczyć transmitancję operatorową ? 
15. Jaki warunek muszą spełniać sygnały układu automatyki aby układ był liniowy. Podać 

przykład sygnału liniowego. 
16. Napisz twierdzenie o liniowości i opisz je; 
17. Napisz twierdzenie o różniczkowaniu; 
18. Napisz twierdzenie o całkowaniu; 
19. Napisz twierdzenie o wartości końcowej. 
20. Dana jest transformata pewnego sygnału. Oblicz, do jakiej wartości dąży sygnał 

rzeczywisty. 
21. Zinterpretuj pojęcie stacjonarności. 
22. Jaką zasadę powinny spełniać układy liniowe ? Podaj ją. 
23. Omów pojęcie transmitancji operatorowej (komentarze); 
24. Sygnały wykorzystywane w analizie właściwości dynamicznych ? (nazwa, funkcja 

czasu, transformata). 
25. Dana jest transmitancja pewnego obiektu. Wyznacz odpowiedź obiektu na skok 

jednostkowy, impuls Diraca, pobudzenie czasowo-liniowe. 
26. Impuls Diraca: przykład i jego praktyczna realizacja. 
27. Skok jednostkowy: przykład i jego praktyczna realizacja; 
28. Pobudzenie czasowo-liniowe: przykład i jego praktyczna realizacja; 
29. Metodyka praktycznego sporządzania charakterystyki amplitudowo-fazowej. 
30. Na podstawie równania różniczkowego (podana będzie postać) wyprowadź 

transmitancję operatorową. Ile wynosi rząd tego obiektu. 
31. Dane jest równanie różniczkowe (podana będzie postać). Wyznacz transmitancję i 

stwierdź, czy opisuje rzeczywisty proces. 
32. Jak wyznaczyć charakterystykę dynamiczną i statyczną układu opisanego równaniem 

różniczkowym (podana będzie postać) przy pobudzeniu sygnałem (będzie podany) ? 
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